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本アプリケーション ノート (AN99209) は、Bluetooth Low Energy (BLE) 4.2の機能、利点、およびアプリケーションの概要を

説明します。また、アプリケーションがサイプレスの PSoC 4／PRoC BLE 4.2デバイスを用いてこれらの機能を使用する方法

についても説明します。 

目次

1 はじめに .................................................................... 1 

2 PSoC／PRoC リソース .............................................. 2 
3 PSoC Creator ........................................................... 3 

3.1 PSoC Creatorヘルプ ........................................ 3 

3.2 サンプル コード .................................................. 4 

4 BLE 4.2機能のご紹介 ............................................... 5 

5 LEデータ パケット長拡張 ........................................... 5 

5.1 利点 .................................................................. 6 

5.2 アプリケーション ................................................. 8 

5.3 PSoC Creatorにおける LEデータ パケット長拡張

機能を使用したアプリケーション開発 .................. 8 

6 Low Energyセキュア コネクション .............................. 9 

6.1 ペアリング プロセスへのアップデート ................. 10 

6.2 利点 ................................................................ 13 

6.3 アプリケーション ............................................... 13 

6.4 PSoC Creator で LE セキュア  コネクションを 

使用したアプリケーション開発 ........................... 13 

7 Link Layer (LL) プライバシー ................................... 15 

7.1 プライバシーのご紹介 ...................................... 15 

7.2 プライバシー コンセプト .................................... 15 

7.3 利点 ................................................................ 19 

7.4 アプリケーション ............................................... 20 

7.5 Link Layer プライバシーを採用したアプリケー 

ションの PSoC Creatorによる開発 .................. 20 

8 まとめ ...................................................................... 23 

9 関連アプリケーション ノート....................................... 23 

A 受動的盗聴に対する防止 ......................................... 24 

B 中間者 (MITM) 攻撃に対する防止 ........................... 25 

B.1 数値比較アソシエーション モデル ..................... 25 

B.2 パスキー入力アソシエーション モデル ............... 27 

B.3 帯域外 (OOB) アソシエーション モデル ............. 27 

改訂履歴 .......................................................................... 28 

ワールドワイドな販売と設計サポート ................................. 29 
 

1 はじめに 

2014年 12月 2日に、Bluetoothスペシャル インタレスト グループ (SIG) は Bluetoothコア仕様バージョン 4.2をリリースし

ました。このバージョンでは次の 3つの主な機能を紹介しました: LEデータ パケット長拡張機能、Link Layerプライバシー機

能 (Privacy 1.2 とも呼ばれる)、および LE セキュア コネクション機能です。この 3 つの機能により、Bluetooth Low Energy 

(BLE；Bluetooth Smart とも呼ばれる) デバイスがよりスマートで、より速く、より安全になり、モノのインターネット (IoT) には

最適です。仕様書をこちらからダウンロードしていただけます。  

サイプレスの PRoC BLE (CYBL11X7X) および PSoC 4 BLE (CY8C4XX8-BL5XX) デバイスは Bluetooth 4.2仕様に完全

に準拠しており、これら 3 つの新機能をサポートします。また、これらのデバイスは、CPU の介入なしにデータ転送を可能に

する DMA コントローラーも備えます。さらに、256KB のフラッシュおよび 32KB の RAM を内蔵しており、外部メモリを必要と

せずに無線 (OTA) ファームウェアの更新を実現できます。レガシーBLEデバイスは、PSoC Creator内の BLEコンポーネン

トをバージョン 3.0以降にアップグレードすることにより LEセキュア コネクション機能をサポートします。表 1は、サイプレスの

異なるデバイスがサポートする Bluetooth 4.2の機能をまとめています。 

http://www.cypress.com/
http://www.cypress.com/AN99209
https://www.bluetooth.org/en-us/specification/adopted-specifications
http://www.cypress.com/creator
http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-datasheet-bluetooth-low-energy-ble
http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-datasheet-bluetooth-low-energy-ble
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表 1. サイプレスのデバイスでサポートされる Bluetoothの新機能 

機能 Bluetooth 4.1対応のデバイス Bluetooth 4.2対応のデバイス 

LEデータ パケット長拡張 無 有 

Link Layerプライバシー 無 有 

LEセキュア コネクション 有 有 

本アプリケーション ノートは、Bluetooth 4.2 の新機能、利点、およびサイプレスの PRoC BLE と PSoC 4 BLE デバイスを 

用いてアプリケーションで使用する方法の基本を説明します。本資料は、読者が BLE アーキテクチャおよび関連技術用語に
ついての基礎知識を持っていることを前提とします。 

▪ BLEまたは PSoCの初心者である場合、アプリケーション ノート「AN91627 - Getting Started with PSoC® 4 BLE」また
は「AN94020 - Getting Started with PRoC™ BLE」を参照してください。 

▪ PSoC Creatorにおける BLEコンポーネントを理解し、標準 BLEサービスに基づいてアプリケーションを開発する方法を
学ぶには、アプリケーション ノート「AN91184 - PSoC 4 BLE Designing BLE Applications」を参照してください。  

▪ Bluetooth仕様については、Bluetooth SIGウェブサイトをご覧ください。 

2 PSoC／PRoC リソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに適切な PSoC (プログラマブル  

システムオンチップ) および PRoC (プログラマブル ラジオオンチップ) デバイスを選択し、迅速かつ効率的にデバイスをデザイン
に統合する手助けをします。リソースの包括的なリストについては、「KBA86521 - How to Design with PSoC 3, PSoC 4, 

and PSoC 5LP」を参照してください。以下は PSoC 4 BLEおよび PRoC BLEのリソースの要約です。 

▪ 概要: Bluetooth® Low Energyポートフォリオ、
サイプレス ワイヤレス／RFロードマップ 

▪ 製品セレクター: PSoC 4 BLEまたは PRoC BLE。
また、PSoC Creatorにはデバイス選択ツールも
含まれます。 

▪ データシートは PSoC 4 BLE および PRoC 

BLE デバイス ファミリの電気的仕様を説明します。 

▪ CapSense設計ガイド: PSoC 4、PSoC 4 BLE、
および PRoC BLE ファミリのデバイスを使用し
て静電容量タッチ センシング アプリケーションを
設計する方法について説明します。 

▪ アプリケーション ノートおよびサンプル コードは
基本的なレベルから高度なレベルまでの幅広い
トピックに触れます。多くのアプリケーション ノー
トはサンプル コードを含みます。 

▪ テクニカル リファレンス マニュアル (TRM) は
PSoC 4 BLEおよび PRoC BLEデバイスのアー
キテクチャとレジスタについて詳細に説明します。 

▪ 開発キット: 

 CY8CKIT-042-BLE の BLE Pioneer Kit に
より、ユーザーは PSoC 4 BLEおよび PRoC 

BLEデバイスを使用して BLEアプリケーション
を評価および開発できます。 

 Bluetooth 4.2 ラジオを搭載している CY8CKIT-

143Aの PSoC 4 BLE 256KB モジュールに
より、ユーザーは CY8C4XX8-BL5XX ファミ
リのデバイスを評価できます。 

 Bluetooth  4.2ラジオを搭載しているCY5676A

の PRoC BLE 256KB モジュールにより、 

ユーザーは CYBL11X7X ファミリのデバイス
を評価できます。 

 CY5677の CySmart BLE 4.2 USB ドングル
により、ユーザーは CySmart PC ツールで
BLE 4.2 の機能をテストおよびデバッグでき
ます。 

 CY5682 の PRoC BLE タッチ マウス リファ
レンス デザイン キット (RDK) を使用し、BLE

タッチ マウスの完全な量産品の開発が可能
です。 

 CY5672の PRoC BLE リモコン リファレンス 

デザイン キット (RDK) を使用し、BLEリモコン
の完全な量産品の開発が可能です。 

▪ MiniProg3デバイスは、フラッシュのプログラミング
とデバッグ用のインターフェースを提供します。 

▪ CySmartはWindows PC用の BLEホスト エミュ
レーション ツールです。このツールはユーザーが
BLE ペリフェラル アプリケーションをテストおよび
デバッグするために使いやすい GUIを提供します。 

▪ モバイル アプリケーションの CySmartはサイプ
レスにより開発される Android™／iOS®アプリケー
ションです。これらのアプリケーションは、サイプ
レスの BLE開発キットを含む、様々な BLE製品
に接続し検証するために使用されます。 

▪ サイプレスのカスタム BLE プロファイルおよび
サービス: サイプレスはいくつかの BLEプロファ
イルおよびサービスを定義しました。これにより、
ユーザーは Bluetooth SIG によって指定された
標準 BLE プロファイルおよびサービスがサポー
トしていない機能に対して BLEを介してデータを
送信できます。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
http://www.cypress.com/documentation/application-notes/an94020-getting-started-proc-ble
http://www.cypress.com/documentation/application-notes/an91184-psoc-4-ble-designing-ble-applications
https://www.bluetooth.com/specifications/adopted-specifications
http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/ble/
http://www.cypress.com/product-roadmaps/cypress-wirelessrf-roadmap-0
http://www.cypress.com/psoc4blepsg
http://www.cypress.com/PRoCBLEPSG
http://www.cypress.com/psoccreator/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1207&f%5b2%5d=resource_meta_type%3A575
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1207&f%5b2%5d=resource_meta_type%3A574
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1207&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1207&f%5b2%5d=software_tools_meta_type%3A577
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-143a-psoc-4-ble-256kb-module-bluetooth-42-radio-0
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-143a-psoc-4-ble-256kb-module-bluetooth-42-radio-0
http://www.cypress.com/documentation/development-kitsboards/cy5676a-proc-ble-256kb-module-bluetooth-42-radio-0
http://www.cypress.com/documentation/development-kitsboards/cy5676a-proc-ble-256kb-module-bluetooth-42-radio-0
http://www.cypress.com/documentation/development-kitsboards/cy5677-cysmart-bluetooth-low-energy-ble-42-usb-dongle
http://www.cypress.com/documentation/development-kitsboards/cy5682-proc-ble-touch-mouse-reference-design-kit-rdk
http://www.cypress.com/documentation/development-kitsboards/cy5672-proc-ble-remote-control-reference-design-kit-rdk
http://www.cypress.com/go/cy8ckit-002
http://www.cypress.com/documentation/software-and-drivers/cysmart-bluetooth-le-test-and-debug-tool
http://www.cypress.com/documentation/software-and-drivers/cysmart-mobile-app
http://www.cypress.com/?rID=112554&source=AN97060
http://www.cypress.com/?rID=112554&source=AN97060
http://www.cypress.com/bleprofile
http://www.cypress.com/bleprofile
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3 PSoC Creator 

PSoC Creator は無料で利用できる Windows ベースの統合開発環境 (IDE) です。これは、PSoC 3、PSoC 4、PSoC 4 

BLE、PRoC BLE、および PSoC 5LPベース システムのハードウェアとファームウェアの同時設計を可能にします。図 1に示
すように、PSoC Creatorを使用すれば、以下のことができます。 

1. コンポーネントをドラッグ＆ドロップして、メイン 

デザイン ワークスペースでハードウェア システム 

デザインを構築 

2. アプリケーションのファームウェアと PSoCハード
ウェアを相互設計 

3. コンフィギュレーション ツールを用いてコンポー
ネントを設定 

4. 100以上のコンポーネントを含むライブラリを利用 

5. コンポーネント データシートをレビュー 

 

図 1．PSoC Creatorの回路図エントリ入力コンポーネント 

Drag and Drop 

Components

Configure Components

Open DatasheetDevelop Firmware

 

3.1 PSoC Creatorヘルプ 

PSoC Creator ホームページへアクセスし、PSoC Creator の最新版をダウンロードしてインストールしてください。次に、
PSoC Creatorを起動して、以下の項目を開きます。 

▪ Quick Start Guide (クイック スタート ガイド): Help > Documentation > Quick Start Guideを選択します。このガイドは
PSoC Creatorプロジェクトを開発するための基礎知識を提供します。 

▪ Simple Component Code Examples (シンプルなコンポーネントのサンプル コード): File > Code Exampleを選択し
ます。これらのサンプル コードは、PSoC Creatorのコンポーネントの設定と使用方法を示します。 

▪ System Reference Guide (システム リファレンス ガイド): Help > System Reference Guideを選択します。このガイドは、
PSoC Creatorが提供するシステム機能を記載し説明します。 

▪ Component datasheets (コンポーネント データシート): コンポーネントを右クリックして「Open Datasheet」を選択します。
すべての PSoC 4／PRoC BLE コンポーネント データシートの一覧を表示するには、PSoC 4／PRoC BLE コンポーネント 

データシート ページをご覧ください。 

▪ Document Manager (ドキュメント マネージャー): PSoC Creatorが提供するドキュメント マネージャーにより、ドキュメント 

リソースを容易に検索し、レビューできます。Document Manager を開くには、メニューから Help > Document 

Managerを選択します。 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/products/psoc-creator
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=software_tools_meta_type%3A532
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=software_tools_meta_type%3A532
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3.2 サンプル コード 

PSoC Creator は多数のサンプル コードを提供します。これらのプロ
ジェクトは、図 2に示すように、PSoC Creatorのスタート ページから
利用可能です。 

サンプル コードにより、空のページの代わりに完成した設計から始める
ことで設計時間を短縮させることができます。サンプル コードはまた、
PSoC Creatorコンポーネントを様々なアプリケーションに使用する方
法を示します。  

図 3に示す Find Example Project ダイアログにはいくつかのオプ

ションがあります。 

▪ アーキテクチャ、デバイス  ファミリ (PSoC 4、PSoC 4 BLE、
PRoC BLEなど)、カテゴリまたはキーワードで絞り込んでサンプル 

コードを検索します。 

▪ Filter Options に基づいて提供されたサンプル プロジェクトの 

メニューから選択します。図 3 に示すように、ご参考のための 30

以上の BLEサンプル コードがあります。 

▪ 選択したデータシートをレビューします (Documentation タブ)。 

▪ 選択したサンプル コードをレビューします。このウィンドウから 

コードをプロジェクトにコピー＆ペーストして、コード開発時間を短

縮させることができます。 

▪ さらに、選択に応じて新規プロジェクト (また、必要な場合は新規

ワークスペース) を作成できます。完成した基本的設計から開始

することで設計時間を短縮できます。その後、設計をアプリケー

ションに適合させることができます。 

PSoC Creator のサンプル コードに加えて、サイプレスの GitHub 

リポジトリから BLEサンプル プロジェクトを見ることもできます。 

図 2. PSoC Creatorのサンプル コード 

  

図 3. コード例およびサンプル コード 

 

http://www.cypress.com/
https://github.com/cypresssemiconductorco
https://github.com/cypresssemiconductorco
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4 BLE 4.2機能のご紹介  

Bluetooth 4.2は、LEデータ パケット長拡張、Link Layer (LL) プライバシー、および Low Energyセキュア コネクションという

3つの主な機能を紹介しました。次の節では、それぞれの新機能を詳細に説明します。  

5 LEデータ パケット長拡張  

Link Layer (LL) は BLEプロトコル スタックの一部分であり、宣伝、スキャン、接続の確立および保持を行います。  

Link Layerパケットのフォーマットは図 4に示されます。それぞれのパケットには 4つのフィールドが含まれます。プリアンブル、

アクセス アドレス、プロトコル データ ユニット (PDU)、および巡回冗長検査 (CRC) です。宣伝、スキャン、または接続の確立

手順中に送信されるパケットは宣伝チャネル PDU を使用します。接続されたデバイスにデータを共有するために送信される

パケットはデータ チャネル PDUを使用します。 

図 4. Link Layerパケットのフォーマット 

Preamble 

(1 byte)

Access Address       

(4 bytes)

Data Protocol Data Unit (PDU)

(2 to 257 bytes in BLE 4.2 & 2 to 33 bytes in BLE 4.1)

CRC

(3 bytes)
 

データ チャネル PDUは、16ビットのヘッダー、サイズ可変なペイロード フィールド、およびオプションのメッセージ インテグリ

ティ チェック (MIC) フィールドを含みます。Bluetooth 4.2仕様では、データ チャネル PDU内のペイロード フィールドの最大

サイズが 27 バイトから 251 バイトに増えるため、データ チャネル自体の容量も約 10 倍になります (より高いスループットを

参照してください)。  

図 5は、Bluetooth 4.2 と Bluetooth 4.1におけるデータ チャネル PDUの違う点を示します。 

図 5. Bluetooth仕様バージョン 4.2 と 4.1における LEデータ チャネル PDU 

 
 

 

LLID

(2 bits)

NESN

(1 bit)

SN

(1 bit)

MD

(1 bit)

RFU

(3 bits)

Length 

(5 bits)

RFU

(3 bits)

Header

(16 bits)
Payload  ( max of 27 bytes ) MIC (32 bits)

LSB MSB
Data Channel PDU in  LL 4.1

LLID

(2 bits)

NESN

(1 bit)

SN

(1 bit)

MD

(1 bit)

RFU

(3 bits)

Length 

(8 bits)

Header

(16 bits)
Payload  ( max of 251 bytes ) MIC (32 bits)

LSB MSB
Data Channel PDU in  LL 4.2

RFU – Reserved For 

Future Use

http://www.cypress.com/
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ヘッダーにある長さフィールドはヘッダーの後に続くデータ バイト数を指定します。ヘッダーにある長さフィールドのサイズは、

Bluetooth 4.1仕様では 5ビットであるが、Bluetooth 4.2仕様では 8ビットに増えるため、長さフィールドの値範囲が 31から

255に増えます。暗号化されたパケットで使用されるメッセージ インテグリティ チェック (MIC) の長さは 4バイトです。そのため、

可能な最大ペイロード サイズは Bluetooth 4.2 では 251 バイトで、Bluetooth 4.1 では 27 バイトです。ヘッダー部の他の 

フィールドについては、「Bluetooth Core Specification Version 4.2」、第 6巻、第 B部、2.4節を参照してください。 

Link Layer は、図 6 に示すように、データ長更新手順を使用して送信方向および受信方向で使用されるペイロード サイズを

調整します。新規に追加された 2 つの Link Layer 制御 PDU である LL_LENGTH_REQ および LL_LENGTH_RSP は、 

デバイスによりサポートされる最大ペイロード サイズを交換するために使用されます。デバイスにより送信される最大ペイロード 

サイズは MaxTxOctets、デバイスにより受信される最大ペイロード サイズは MaxRxOctets と呼ばれます。送信 (TX) および

受信 (RX) の実際のペイロード サイズはデータ長更新手順により判定されます。実際の TXペイロード サイズはローカルの

MaxTxOctets とピアの MaxRxOctets パラメーターの最小値であり、同様に、実際の RX ペイロード サイズはローカルの

MaxRxOctets とピアの MaxTxOctets パラメーターの最小値です。Link Layer は、データ長更新手順が完了するまで、27 

バイトのデフォルトのペイロード サイズを使用します。この機能をサポートしないデバイスは、LL_LENGTH_REQ の PDU を

受信した際に LL_UNKNOWN_RSPの PDUで応答します。その場合、Link Layerは 27バイトのデフォルト ペイロード サイズ

を使用します。 

図 6. データ長更新手順  

Link Layer Master Link Layer Slave

LL_LENGTH_REQ 

( MaxRxOctets, MaxTxOctets)

LL_LENGTH_RSP 

( MaxRxOctets, MaxTxOctets)TX payload size = 

min(MaxTxOctects of 

master,MaxRXOctets of slave)

RX payload size = 

min(MaxRxOctects of 

master,MaxTXOctets of slave)  

TX payload size = 

min(MaxTxOctects of slave 

,MaxRXOctets of master)

RX payload size = 

min(MaxRxOctects of slave, 

MaxTXOctets of master)   

5.1 利点 

LEデータ パケット長拡張機能により、アプリケーションはより高いスループット、より低い消費電力、および非対称の帯域幅を

実現できます。これらの利点は、以下の条件を満たした場合にのみ実現できます。 

▪ 両方の BLEデバイスが LEデータ パケット長拡張機能をサポート   

▪ 上位層のプロトコルが最大伝送単位 (MTU) サイズのデフォルト値 (23バイト) よりも大きなサイズを使用  

5.1.1  より高いスループット  

LE データ パケット長拡張機能により、Link Layer を介して約 2.6 倍のより高いスループットを実現できます。図 4 は Link 

Layerパケットのフォーマットを示し、図 5はデータ チャネル PDUの様々なフィールドを示します。MICフィールドは、ペイロー

ド サイズが 0でないデータ チャネル PDUの暗号化されたパケットのみに追加されます。 

ペイロード サイズが 0 バイトの場合、パケットの最短転送時間が 80µs です。Bluetooth 4.1 では、パケットの最長転送時間

は 328µs (ペイロード サイズが 27バイト) です。Bluetooth 4.2では、パケットの最長転送時間は 2120µs (ペイロード サイズ

が 251バイト) です。 

図 7 には、Bluetooth 4.1 および Bluetooth 4.2 それぞれの場合のデータ転送中の一般的な Link Layer トランザクションを 

示します。単一のデータ パケットのトランザクションは、パケットを含まない RX (ペイロード サイズ=0)、150µsのフレーム間隔

時間 (T_IFS)、ペイロード サイズが最大なパケットの TX、および T_IFSから構成されます。次の RX動作が行われると 1つ

のトランザクションが終了します。その時点で手順が繰り返されます。図に示している 2 番目の RX は、最初の TX パケットが

認識され、新しいトランザクションが開始するところです。 

http://www.cypress.com/
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図 7. Link Layerのトランザクション 
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4.1 Link Layer Transaction

4.2 Link Layer Transaction

 

Link Layerのスループット (すなわち、BLEプロトコル スタックの上位層に利用可能なスループット) は以下のように定義され

ます。  

スループット = ペイロード サイズ / 単一トランザクションの時間 

Bluetooth 4.1では、ペイロード サイズが 27バイト (216ビット) であり、単一トランザクションの合計時間が 708µsです。よって、

理論上のスループットが 298kbpsになります。 

Bluetooth 4.2では、ペイロード サイズが 251バイト (2008ビット) で、合計時間が 2500µsであるため、理論的なスループットが

784kbpsになります。これで、Bluetooth 4.1のデバイスに比べて、 Bluetooth 4.2のデバイスでは約 2.6倍のスループットが

得られます。 

5.1.2  低消費電力  

エア干渉がないという理想的な状況下では、LE データ パケット長拡張機能は、帯域幅をより効率良く使用することで消費電

力を削減するのに役立ちます。  

Bluetooth 4.2では、一定のデータを転送するのに必要なトランザクションの数は Bluetooth 4.1に比べて少ないです。これは、

ラジオがアクティブ状態にある時間を減少させ、デバイスが低電力モードにある時間を長めにすることで、平均電流消費量を

削減します。 

図 8に示しているのは、135バイトの Link Layerペイロードを仮定した場合のメカニズムです。Bluetooth 4.1では、135バイト

のペイロードが 27バイトのペイロードに分割され、5つのトランザクションで送信されます。Bluetooth 4.2 では、135 バイトの

ペイロードが単一のトランザクション内で送信されます。  

図 8. 135バイトのデータ転送例 
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5.1.3  非対称の帯域幅   

非対称の帯域幅とは TXと RXの帯域幅が同じでないことを意味します。RX方向でより高い帯域幅を、TX方向でより低い帯

域幅を必要とする無線 (OTA) ファームウェア アップグレード等のようなアプリケーションには有用です。MaxTxOctetsおよび

MaxRxOctets パラメーターに適切な値を選択することで非対称の帯域幅を取得できます。例えば、MaxTxOctets を 251 バ

イトに、MaxRxOctets を 27バイトに設定すれば、送信方向の帯域幅が増幅されます。同様に、MaxTxOctets を 27バイトに、

MaxRxOctetsを 251バイトに設定することで受信方向の帯域幅が増幅されます。 

5.2 アプリケーション 

▪ BLE経由の音声送信は、高帯域幅を利用してデータを圧縮するのに必要な処理電力を低減させられます。  

▪ 無線 (OTA) ファームウェア アップグレードは低消費電力で、より短い時間で完了できます。 

▪ インターネット プロトコル サポート プロファイル (IPSP) パケットはより迅速に交換され、その結果、より高速な検出とトラン

ザクションに繋がります。 

▪ 複数のセンサーからのデータは、データ ペイロード サイズの増加に伴ってより迅速にログすることができます。 

5.3 PSoC Creatorにおける LEデータ パケット長拡張機能を使用したアプリケーション開発  

5.3.1  コンポーネントの構成  

LE データ パケット長拡張機能を使用するには、図 9 に示しているとおりに、GAP Settings > General セクションで Link 

Layer max TX payload size (bytes)パラメーターの MaxTxOctets、Link Layer max RX payload size (bytes) パラメー

ターの MaxRxOctetsの適切な値で BLEコンポーネントを設定しなければなりません。 

図 9. BLEコンポーネントで LEデータ パケット長拡張機能を設定 

 

5.3.2  アプリケーションの取り扱い  

BLE スタックは、ピア デバイスとの接続が確立した後、直ちにコンポーネントの設定に基づいて自動的に TX と RX のペイ 

ロード サイズを調整します。表 2は、BLEスタック イベントの説明および LEデータ パケット長拡張機能を活用するのに取る

べきアクションをまとめたものです。 

表 2 BLEスタック イベントおよび LEデータ パケット長拡張機能に対するアクション 

BLEスタック イベント名 イベントの説明 イベント ハンドラの応答処理 

CYBLE_EVT_GAP_DATA_LENGTH_CHANGE 調整された TXと RXの長さを 

レポートする  

参考になるイベント  

http://www.cypress.com/
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通信に調整された送信と受信の最大ペイロード サイズは CYBLE_EVT_GAP_DATA_LENGTH_CHANGE BLEスタック イベントを

介してアプリケーションにレポートされます。アプリケーション ファームウェアはこのイベントを使用して通信に対する TX および

RXの最大ペイロード サイズの変更を確認できます。 

表 3は、LEデータ パケット長拡張機能をサポートする新しい APIの一覧 (説明欄付き) を示します。 

表 3. LEデータ パケット長拡張機能用の新 API 

API 説明 

CyBle_GapSetDataLength TXペイロード サイズを新しく設定し、新規のデータ長更新手順を開始する 

 

接続後、MaxTxOctetsパラメーターは CyBle_GapSetDataLengthの APIを使用することによりいつでも変更できます。この

API は新規のデータ長更新手順を開始し、その手順が完了した後に実際に送受信されたペイロード  サイズが

CYBLE_EVT_GAP_DATA_LENGTH_CHANGE イベント経由でアプリケーションにレポートされます。 

BLEプロトコル スタック イベントおよび APIの詳細については、BLEコンポーネント データシーを参照してください。  

5.3.3  サンプル  プロジェクト  

PSoC Creatorで利用可能な BLE_4.2_DataLength_Security_Privacy サンプル プロジェクトは LEデータ パケット長拡

張機能を使用します。図 10に示すように、PSoC Creator > File > Code Exampleで BLEに絞り込むことでサンプル プロ

ジェクトにアクセスできます。 

図 10. BLE 4.2サンプル プロジェクト 

 

6 Low Energyセキュア コネクション 

ペアリングは、2つの BLEデバイス間の認証およびキー共有プロセスです。図 11に示すように、ペアリングは 3段階プロセス

です。LEセキュア コネクションは、Bluetooth 4.2で紹介されている拡張セキュリティ機能です。キーを生成するためには楕円

曲線ディフィー ヘルマン (ECDH) と呼ばれる連邦情報処理標準 (FIPS) に準拠するアルゴリズムを使用し、およびキーを 

共有するためには新たな手順を使用します。BLEにおけるアソシエーション モデルは、2つの BLEデバイスの入出力機能に

基づいてペアリング方法を定義するモデルです。Bluetooth 4.2は数値比較 (NC) と呼ばれる新しいアソシエーション モデル

を紹介します。  

http://www.cypress.com/
http://www.cypress.com/documentation/component-datasheets/bluetooth-low-energy-ble
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図 11. ペアリング プロセス 

 

次の節では、ペアリングの 3段階プロセス、および LEセキュア コネクション機能のそれぞれのフェーズへの影響を説明します。 

6.1 ペアリング プロセスへのアップデート 

6.1.1  ペアリング第 1 フェーズ  

フェーズ 1 においては、発信デバイスおよび応答デバイスは入出力機能、認証要求フラグ、暗号化キーのサイズ、および 

帯域外 (OOB) データの可用性等のペアリング パラメーターを共有します。図 12に示しているように、ペアリング プロセスの

フェーズ 1は LEレガシー ペアリングおよび LEセキュア コネクションの間で共通です。 

図 12. LEペアリング第 1フェーズ 

 
 

発信デバイス (Link Layer マスター) はペアリング リクエストのコマンドを使用してパラメーターの交換を開始します。応答 

デバイス (Link Layeyスレーブ) はペアリング レスポンスのコマンドで応答します。また、応答デバイスはセキュリティ リクエスト

のコマンドを使用してペアリング プロセスも開始できます。 

認証要求フラグはペアリング パラメーターの一部です。Bluetooth 4.2 では、これらのフラグはセキュア コネクション (SC)  

およびキープレスと言った 2 つの新規フィールドを追加するために更新されます。図 13 には Bluetooth 4.1 および 4.2 それ

ぞれのペアリング パラメーターと認証要求フラグを示します。  

http://www.cypress.com/
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図 13. ペアリング パラメーター 

 

フェーズ 2のペアリング方法またはアソシエーション モデルはフェーズ 1の間に交換されたパラメーターにより判定されます。
以下がフェーズ 2に使用できる 4つのペアリング方法またはアソシエーション モデルです。 

▪ Just Works (ジャスト ワーク) 

▪ Numeric Comparison (数値比較；LEセキュア コネクション専用) 

▪ Passkey Entry (パスキー入力) 

▪ Out Of Band (帯域外；OOB) 

表 4. LEセキュア コネクションにおけるアソシエーション モデルの判定 

  発信デバイス 

  OOB データ フラグが

設定済み 

OOB データ フラグ

が未設定 

MITMが設定済み MITMが未設定 

応
答
デ
バ
イ
ス

 

OOBデータ フラグが設定済み OOBを使用 OOBを使用   

OOBデータ フラグが未設定 OOBを使用 MITMをチェック   

MITMが設定済み   I/O機能を使用 I/O機能を使用 

MITMが未設定   I/O機能を使用 ジャスト ワークを使用 

 

表 4では、LEセキュア コネクションにおいてアソシエーション モデルがフェーズ 1で交換されたペアリング パラメーターに基
づいてフェーズ 2 でどのように判定されるかを示します。LE セキュア コネクションでは、発信デバイスおよび応答デバイスの両
方とも表示機能と「はい／いいえ」I/O 機能、または表示機能とキーボード I/O 機能を内蔵している場合、数値比較のアソシエ
ーション モデルが使用されます。I/O 機能に基づきアソシエーション モデルがどのように判定されるか、そして片方の BLE

デバイスまたは両方の BLE デバイスが LE レガシー ペアリングのみをサポートする場合の詳細情報については、Bluetooth 

Core Specification Version 4.2、第 3巻、第 H部、2節をご覧ください。 

http://www.cypress.com/
https://www.bluetooth.com/specifications/adopted-specifications
https://www.bluetooth.com/specifications/adopted-specifications
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6.1.2  ペアリング第 2 フェーズ  

ペアリング プロセスのフェーズ 2は、中間者 (MITM) 攻撃を防止するための認証、および BLEリンクを暗号化するために使

用されるキーの生成に関連します。  

LEレガシー ペアリング方法では、一時キー (ジャスト ワーク モデルの場合は 0、パスキー入力モデルの場合は 6桁または

20 ビット、OOB モデルの場合は 128 ビット) は BLE リンクを暗号化するキーを取得するために使用されます。この一時キー

は、BLE リンクをとおって交換されない唯一のランダム データです。LE レガシー ペアリング方法の詳細については、

「Bluetooth Core Specification Version 4.2」、第 3巻、第 H部、2.3.5節を参照してください。 

図 14に示すように、LEセキュア コネクションにおけるフェーズ 2は 3つの過程を含みます。  

図 14. LEセキュア コネクション ペアリングにおけるフェーズ 2 

 

公開キー交換の過程では、発信デバイスおよび応答デバイスはお互いの公開キーを共有し、ディフィー ヘルマン キーを計算

し始めます。ディフィー ヘルマン キーは楕円曲線ディフィー ヘルマン機能、P256 で生成されたキーです。P256 はデバイス

固有の秘密キーとペア デバイスの公開キーを入力として取り扱います。ディフィー ヘルマン キーは決して無線で交換されず、

256ビットの乱数を提供します。ECDHアルゴリズムが秘密キーを BLE リンク経由で交換することなく発信デバイスおよび応

答デバイスの両方を有効にし、共通のディフィー ヘルマン キーを計算する方法を理解するには、受動的盗聴に対する防止

を参照してください。  

認証過程 1 では、中間者 (MITM) 攻撃を防ぐために BLE デバイス同士が相互に認証し合います。認証過程 1 はそれぞれ

のアソシエーション モデルによって異なります。数値比較、パスキー入力、および OOBのアソシエーション モデルを使用する

認証過程 1で MITM攻撃に対して高度な保護を提供する方法を理解するには、中間者 (MITM) 攻撃に対する防止を参照し

てください。認証過程 1で何らかの誤りが発生するとペアリング プロセスもそこで終了してしまいます。  

認証過程 2では、BLEデバイスはリンクを暗号化するために使用される Long Term Key (長期キー；LTK) を計算します。認

証過程 1で生成されたディフィー ヘルマン キー、Bluetoothデバイス アドレス、128ビットの乱数、およびデバイスの I/O機能

は LTKを生成するために使用されます。  

LEセキュア コネクションにおける認証過程その 1 と 2の詳細については、「Bluetooth Core Specification Version 4.2」、第

3巻、第 H部、2.3.5.6節をご覧ください。  

6.1.3  ペアリング第 3 フェーズ  

ペアリングの第 3 フェーズでは、BLE リンクは、フェーズ 2 で生成された STK (LE レガシー ペアリングの場合) または LTK 

(LE セキュア コネクション ペアリングの場合) を使用して暗号化されます。そして、以下のキーが暗号化されたリンクをとおし

て配布されます。 

1. Identity Resolving Key (IRK) - ランダムのアドレスを生成し、解読するために使用される 128ビットのキー 

2. Connection Signature Resolving Key (CSRK) - データを署名し、受信側でその署名を検証するために使用される 128

ビットのキー 

3. Long Term Key (LTK) - 暗号化された通信に対してセッション キーを生成するために使用される 128ビットのキー詳細

は、「Bluetooth Core Specification Version 4.2」、第 6巻、第 B部、5.1.3節を参照 

4. Encrypted Diversifier (EDIV) - LEレガシー ペアリング中に配布された LTKを識別するために使用される 16ビットの

保持値。ユニークな LTKが配布される度に新しい EDIVが生成される 

5. Random Number (Rand) - LEレガシー ペアリング中に配布された LTKを識別するために使用される 64ビットの保持

値。ユニークな LTKが配布される度に新しい Randが生成される 

 LTK、EDIVおよび Randは LEレガシー ペアリングの場合にのみ配布されます。  

http://www.cypress.com/
https://www.bluetooth.com/specifications/adopted-specifications
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6.2 利点 

6.2.1  より良いセキュリティ  

LEセキュア コネクションは、LEレガシー ペアリングより、MITM攻撃および受動的盗聴に対するセキュリティ性が高いです。  

受動的盗聴者は、2 つの BLE デバイス間の通信を盗聴する第三者です。受動的盗聴者は暗号化された通信を盗聴するために、

BLE リンク経由で配布されたキーを横取りする必要があります。LE セキュア コネクションのあらゆるアソシエーション モデル

では、256 ビットのディフィー ヘルマン キーは無線で交換されることは決してありません。そのため、受動的盗聴者は暗号化

用に使われる Long Term Key (LTK) を計算できず、その結果、暗号化された BLE通信を盗聴することもできなくなります。

Bluetooth 4.1 では、受動的盗聴への防止は OOB アソシエーション モデル経由でのみ可能になり、128 ビットの一時キーを

使用するため防止能力そのものが低いです。LE セキュア コネクションにおいて 2 つの BLE デバイスがどのように共通の 

ディフィー ヘルマン キーを計算できるかを理解するには、受動的盗聴に対する防止を参照してください。 

MITM攻撃は、通信に接続しようとするデバイスに対してピア デバイスに扮する第三者の攻撃です。ピア デバイスに扮するこ

とにより 2 つのデイバス間で交わされているデータを変更します。数値比較、パスキー入力、および OOB のアソシエーション 

モデルは MITM攻撃に対してより高度な保護を提供します。これらのアソシエーション モデルがどのように MITM攻撃から保

護できるかを理解するには、中間者 (MITM) 攻撃に対する防止を参照してください。数値比較はパスキー入力よりも高速なペ

アリングを可能にし、OOBのように独立した通信リンクを必要としません。 

表 5では、LEレガシー ペアリングおよび LEセキュア コネクションそれぞれの異なるペアリング方法の保護レベルをまとめま

す。  

表 5．LEレガシー ペアリングおよび LEセキュア コネクション ペアリングの比較 

機能 LEレガシー ペアリング方法 LEセキュア コネクション ペアリング方法  

MITMに対する防止 パスキーと OOB 数値比較、パスキー入力、OOB 

受動的盗聴に対する防止 OOB すべて 

6.2.2  セキュア  コネクション専用モード  

このモードは LEセキュア コネクションを使用して厳密なペアリングを強制的に行います。どちらか一方のデバイスが厳格なペ

アリング フラグを設定した場合、ペアリング プロセスのフェーズ 2は、双方のデバイスが LEセキュア コネクションをサポートし、

認証要件を満たした時にのみ行われます。これは高度なセキュリティが必要とされるアプリケーションには非常に有用です。  

6.3 アプリケーション 

ドア ロック、銀行カード、および高度なセキュリティを求める他のアプリケーションは Bluetooth 4.2 の強化されたセキュリティ

機能を活用できます。  

6.4 PSoC Creatorで LEセキュア コネクションを使用したアプリケーション開発  

6.4.1  コンポーネントの構成  

BLEコンポーネントは、セキュリティ モード、 セキュリティ レベル、厳格なペアリング要求、MITMへの防止、I/O機能、ボンディング

要求、および暗号化キー サイズを設定するための簡単な方法を提供します。アプリケーションで LE セキュア コネクションを

使用するには、Gap Settings > Securityに移動し、Security modeパラメーターをMode 1に、Security levelパラメーター

を Authenticated LE Secure Connections pairing with encryptionに設定します。他のパラメーターは対象アプリケー

ションの要求に応じて設定できます。 

http://www.cypress.com/
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図 15. BLEコンポーネントのコンフィギュレーション: セキュリティ設定 

 

6.4.2  アプリケーションの処理  

LEセキュア コネクション機能を使用する際に、アプリケーション ファームウェアは以下の作業を管理する必要があります。 

▪ ローカルの公開キーと秘密キーのペアの生成 

▪ 数値比較の場合は数値の表示；パスキー入力の場合はパスキーの表示・入力  

▪ パスキー入力状態の送信  

▪ パスキーの送信  

▪ 数値比較の場合に表示される数値に対する採否情報の送信 

表 6は、BLEスタック イベントそれぞれの説明、および LEセキュア コネクション機能を使用する際に取るべきアクションをま

とめたものです。 

表 6. LEセキュア コネクションにおける BLEイベントおよび応答処理  

BLEスタック イベント名 イベントの説明 イベント ハンドラの応答処理 

CYBLE_EVT_GAP_NUMERIC_COMPARISON_REQUEST 数値比較に表示される 6桁の数値を提

供する  

6桁の数値を表示する 

数値比較に双方のデバイスに表

示される数値を元に採否情報を

送信する  

CYBLE_EVT_GAP_KEYPRESS_NOTIFICATION ピア側のパスキー入力状態を通知する ピア側から通知された数値と対

象デバイスでユーザーが入力し

た数値が一致するか確認する 

一致しない場合は通信を切断する 

CYBLE_EVT_GAP_OOB_GENERATED_NOTIFICATION OOBデータの生成が完了した旨を通

知する 

アプリケーション特有のアクション 

CYBLE_EVT_GAP_SMP_NEGOTIATED_AUTH_INFO 調整されたペアリング パラメーターを通

知す  

アプリケーション特有のアクション 

http://www.cypress.com/
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表 7は、LEセキュア コネクションが有効なアプリケーションで使用される新しい APIを一覧化したものです。 

表 7. LEセキュア コネクション用の新 API 

API 説明 

CyBle_GapSetSecureConnectionsOnlyMode セキュア コネクション専用モードを有効化または無効化 

CyBle_GapGenerateLocalP256Keys ローカルの公開キーと秘密キーを生成 

CyBle_GapAuthSendKeyPress キープレス状態を送信 

CyBle_GapGenerateOobData OOBデータを生成  

 

イベントおよび APIの詳細については、BLEコンポーネント データシートをご覧ください。  

6.4.3  サンプル  プロジェクト  

PSoC Creatorで利用可能な BLE_4.2_DataLength_Security_Privacyサンプル プロジェクトは LEセクイア コネクションを
使用します。図 10に示すように、PSoC Creator > File > Code Exampleで BLEに絞り込むことでサンプル プロジェクトに
アクセスできます。 

7 Link Layer (LL) プライバシー  

7.1 プライバシーのご紹介 

BLEデバイスは 48ビットのデバイス アドレスを用いて識別されます。このデバイス アドレスは宣伝チャネルでデバイスにより
送信されたすべてのパケットの一部です。3つの宣伝チャネルでリッスンしている第三者はデバイス アドレスを使用することで
そのデバイスのアクティビティーを容易に追跡できます。プライバシーは、一定の間隔で生成され変更されるプライベートなア
ドレスを使用して BLEデバイスを追跡する能力を低下させる機能です。  

7.2 プライバシー コンセプト 

7.2.1  Bluetooth アドレス  タイプ  

図 16には、BLEデバイスの異なるアドレス タイプを示します。 

図 16．Bluetoothアドレス タイプ 

Device address

Public device address Random device address

Static address Private address

Resolvable private 

address

Non-Resolvable 

private address  

デバイス アドレスはパプリック デバイス アドレスかランダム デバイス アドレスのいずれかです。パプリック デバイス アドレスは、
24ビットの企業 ID (IEEE 802-2001標準に準拠した企業のユニークな識別子またはOUI) および企業が割り振る 24ビットの数
値 (デバイス固有) から構成されます。ランダム デバイス アドレスにはスタティック アドレスとプライベート アドレスの 2種類が
あります。スタティック アドレスは、ランダムに生成される 48ビットのアドレスであり、その 48ビット アドレスの最上位の 2ビット
が 1に設定されます。パプリック デバイス アドレスは時間を経ても変わらないものです。スタティック アドレスはデバイスの電
源を一度切って再投入した時にのみ変更できます。これらいずれかのアドレスを使用しているデバイスはピア デバイスにより
容易に検出され、接続できます。プライベート アドレスは、BLE デバイスが追跡されないことを確保するために、一定の間隔
で変更します。解読不可能なプライベート アドレスは再接続する度に変更します。解読不可能なプライベート アドレスは、ピア 

デバイスにより解読されず、前の通信中にピア デバイスと共有しなければなりません。解読可能なプライベート アドレス 

(RPA) は一定の間隔で変更し、解読でき、プライバシーが有効なデバイスにより使用されます。本アプリケーション ノートでは、
プライバシー機能の範囲内で RPA について説明します。異なるアドレス  タイプの詳細については、Bluetooth Core 

Specification Version 4.2を参照してください。  

http://www.cypress.com/
http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-datasheet-bluetooth-low-energy-ble
http://standards.ieee.org/findstds/standard/802-2001.html
https://www.bluetooth.com/specifications/adopted-specifications
https://www.bluetooth.com/specifications/adopted-specifications
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プライバシー機能が有効なすべての BLE デバイスには、アイデンティティー アドレスと呼ばれるユニークなアドレスがあります。
そのアイデンティティー アドレスは BLEデバイスのパプリック アドレスまたはスタティック アドレスです。また、プライバシー機
能が有効なあらゆる BLEデバイスは Identity Resolving Key (IRK) を持ちます。IRKは RPAを生成するために BLEデバイ
スにより使用され、BLE デバイスの RPA を解読するためにピア デバイスにより使用されます。アイデンティティー アドレスと
IRKの両方ともペアリング プロセスの 3番目の過程で交換されます。プライバシーが有効な BLEデバイスは、ピア デバイス
のアイデンティティー アドレス、RPAを生成するために BLEデバイスにより使用されるローカル IRK、およびピア デバイスの
RPA を解読するために使用されるピア デバイスの IRK を含むリストを保持します。それは Resolving List と呼ばれます。
Resolving Listに入力する際は、図 17に示しているフォーマットに従います。 

図 17. Resolving List 

Identity address Local IRK Peer IRK

 

プライバシーが有効な BLEデバイスは追跡を回避するために RPAを周期的に変更します。BLEスタックは RPA タイムアウト
と呼ばれる値で Link Layerを設定します。このタイムアウト時間が満了すると Link Layerは新しい RPAを生成しなければな
りません。  

7.2.2  プライバシーの流れ  

図 18は、プライバシー機能を使用しようとする 2つの BLEデバイス間に確立される初期接続を示します。この図を見れば分
かるように、片方のデバイスが Generic Access Profile (GAP) のペリフェラル役割を、残りの片方のデバイスが GAP 

セントラルの役割を果たします。GAP および Bluetooth デバイスで利用可能な様々な役割の詳細については、Bluetooth 

Core Specification Version 4.2、第 3巻、第 C部、2.2.2節をご覧ください。 

図 18. プライバシー機能を使用しようとするデバイス間に確立された初期接続 

 

上の図に見られるように、初期の接続を確立している間に GAPペリフェラルおよび GAPセントラルは宣伝チャネル経由で送
信されるすべてのパケットにおいてアイデンティティー アドレス (ペリフェラルの場合は IAp、セントラルの場合は IAc) を使用し
ます。これはもともと両方のデバイスともピア デバイスの IRKを意識しなかったため、ピア デバイスの RPAを解読できなくな
るからです。宣伝チャネル経由で送信されるパケットは以下のとおりです。 

▪ 接続可能無向宣伝: これは特定の受信者 (すなわち、特定の GAPセントラル) に向けていない宣伝パケットです。これら
の宣伝は GAPセントラルのアドレスを含まず、GAPペリフェラル、すなわち、宣伝側のアドレスのみを含みます。 

▪ 任意のスキャン要求およびスキャン応答: スキャン要求は GAP セントラルにより送信され、ペリフェラルに接続する前に

ペリフェラルに対してデータを追加するように要求します。スキャン応答はペリフェラルにより送信され、要求されたデータ

を含みます。これら両方のパケットは任意です。 

▪ 接続要求: これは通信を開始するために GAPセントラルから GAPペリフェラルへ送信する要求です。 

http://www.cypress.com/
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上記以外の他のすべてのパケットはデータ チャネル上で送信され、Bluetooth デバイス アドレスを含みません。接続要求 

パケットは宣伝チャネルで送信される最後のパケットです。GAP セントラルおよび GAP ペリフェラルのアイデンティティー  

アドレスの他に、接続要求パケットはアクセス アドレスと呼ばれる 32 ビットの乱数も含んでいます。アクセス アドレスは 2 つ
の BLE デバイス間の Link Layer 通信を識別します。接続が確立される度に、すなわち、接続要求が送信される度に新しい
アクセス アドレスが生成されます。データ チャネル上で交換される BLEデバイス間のすべてのパケットはアクセス アドレスを
使用し、その 2つのデバイス間の通信を識別します。それはペアリングおよびデータ交換用のパケットです。 

ペアリング プロセスの 3番目の過程 (ペアリング プロセスの詳細は 6.1を参照) では、GAPセントラルおよびGAPペリフェラル
は IRK とアイデンティティー アドレスをペアリングに関連するパケットのペイロードの一部として交換します。両方のデバイス
は、ローカルの IRK と共にピアの IRK とアイデンティティー アドレスを Resolving List に格納します。この過程では、両方の
デバイスは RPA を解読するのに必要な情報を持っているため、両方とも RPA タイムアウトを設定し、アドレス ソリューション
を有効にします。双方のデバイスは、デバイスをフィルタリングするために、ピア デバイスのアイデンティティー アドレスを
Whitelist に追加することもできます。Whitelist は、Bluetooth デバイス アドレス一式です。BLE デバイスの Link Layer はそ
のデバイス アドレスを使用し、宣伝者、スキャナー、および通信のイニシエーターをフィルタリングします。Whitelist はデバイス 

フィルタリング機能が有効な場合にのみ使用されます。その場合、デバイスは BLEデータ チャネル上でデータを交換します。
この時、デバイスは Resolving Listのピア RPAを解読するのに必要な情報を持っているため、再接続手順ではその RPAを
使用します。図 19は、デバイスが初期接続の確立後に一旦切断してまた接続するというシナリオを示します。 

図 19. RPAを使用した再接続 

 

上述のとおりに、ここでデバイスは宣伝チャネル経由で送信されるあらゆるパケットで RPA を使用します。そのため、宣伝 

チャネル上のデバイス間の通信は第三者のいかなるデバイスによりも追跡されません。GAP ペリフェラルは再接続するため

に接続可能無向宣伝または接続可能有向宣伝を使用できることに注意してください。7.2.5節では、Bluetooth 4.2を搭載して

いるプライバシー機能が有効なデバイスが接続可能有向宣伝のみをサポートする理由を説明します。スキャン要求および 

スキャン応答パケットは、GAP ペリフェラルが接続可能無向広報を使用する時にのみ使用されます。GAP ペリフェラルが接

続可能無向宣伝を使用する場合、GAP セントラルは接続要求でのみ応答できます。プライバシーは、宣伝チャネル上の通信

による BLE デバイスのトラッキングを防止することにご注意ください。データ チャネル パケットは、接続が確立されるたびに 

生成されるランダムのアクセス アドレスを使用するため、トラッキングに影響されません。プライバシーはデータ チャネル  

パケットに影響を与えません。  

7.2.3  解読可能プライベート  アドレス  (RPA)  の生成  

本節では、プライバシー機能を備えた BLE デバイスがどのように RPA を生成するかを説明します。解読可能プライベート  

アドレスのフォーマットは Bluetooth仕様書に記述されており、図 20に示されます。  

図 20. 解読可能プライベート アドレス フォーマット 
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デバイスは、prand と呼ばれる 24 ビットの数値 (22 ビットはランダムで、2 ビットは固定) を生成します。デバイスは prand を
使用して hash関数により 24ビットの hashを生成します。  

hash = e(IRKlocal, padding | prand )、24ビットに切り捨てられる 

http://www.cypress.com/
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ここで、 

IRKlocal = 128ビットのローカル IRK 

Padding = prandを 128ビットに拡張するための 104ビットのゼロ パディング 

prand = 24ビットの乱数 (22ビットはランダムで、最上位 2ビットは 0b10にセットされる) 

セキュリティ関数「e」は、PSoC 4／PRoC BLEデバイスの Link Layerハードウェアに実施された 128ビット暗号化関数です。
これは、FIPS-1971で定義されたように、128ビットの key と 128ビットの plaintextDataから 128ビットの encryptedDataを
生成します。 

encryptedData = e(key, plaintextData) 

24ビット hash と 24ビット prandは連結られ、以下のようにランダム アドレス (randomAddress) を生成します。 

randomAddress = hash | prand 

解読可能プライベート アドレスの生成は図 21に示されます。 

図 21. 解読可能プライベート アドレスの生成 
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7.2.4  解読可能プライベート  アドレスの解読  

本節では、プライバシー機能を備えた BLE デバイスがどのようにピア デバイスの RPA を解読するかを説明します。ピア  

デバイスから受信された RPA は、7.2.3 節で説明されたように、24 ビットのランダム部分 (prand) と 24 ビットの hash 

部分 (hash) から成ります。アドレスを解読／復号するために、RPA の最下位 24 ビットと最上位 24 ビットそれぞれはピア  

デバイスの hash と prandに抽出されます。その後、前述された hash 関数により localHash値が生成されます。hash 関数
では、入力パラメータはピア デバイスから受信された IRKにセットされ、入力パラメータ prand値は RPAから抽出されます。 

localHash = e(IRKpeer, padding | prand )、24ビットに切り捨てられる 

localHash 値は、RPA から抽出された hash 値と比較されます。localHash 値が抽出された hash 値と一致したら、ピア  

デバイスのアイデンティティは解読されたとみなされます。アドレスの解読は図 22に示されます。 

図 22. 解読可能プライベート アドレスの解読 

Hash (24 bits)

Random part of prand10

MSB

prand (24 bits)

104 bit zero 

padded prand 
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7.2.5  プライバシー1.1 とプライバシー1.2 の比較   

Bluetooth 4.1 において、プライバシー機能はプライバシー1.1 と呼ばれます。Bluetooth 4.2 においては、プライバシー機能
はプライバシー1.2 (Link Layerプライバシー) と呼ばれます。理由は、Bluetooth 4.2ではアドレスの解読 (すなわち、RPAの
解読) は Link Layer によって処理されるためです。図 23 に示されるように、Bluetooth 4.2 では、Resolving List および
Whitelistは Link Layerの一部です。  

図 23. Bluetooth 4.1のプライバシー1.1 と Bluetooth 4.2のプライバシー1.2の比較  

 

接続可能有向宣伝は、宣伝側および受信側の RPAを含みます。Bluetooth 4.2の Link Layerプライバシー機能により、Link 

Layerは Resolving Listを使用して RPAを解読できます。そのため、Link Layerは受信側が接続可能有向宣伝の対象となる

受信側であるかを理解できます。また、Bluetooth 4.1 と Bluetooth 4.2は RPAタイムアウトの許容値で違います。Bluetooth 

4.2では、RPAタイムアウトの値は 1秒～11.5時間の任意の値であり、デフォルト値は 900秒です。Bluetooth 4.1では、RPA

タイムアウトは 15分に固定されます。 

7.3 利点 

7.3.1  高速な再接続  

7.2.5 節では、プライバシー機能を備えたデバイスが再接続のために接続可能有向宣伝をどのように使用するかを説明しました。

Bluetooth 4.1では、プライバシー機能によるデバイス フィルタリングはできません。Link Layerは Resolving Listへのアクセス

がありません。そのため、Link Layer は RPA をアイデンティティー アドレスに解読することも、Whitelist を使用してアイデン 

ティティー アドレスをフィルタリングすることもできません。Bluetooth 4.2 では、図 23 に示すように、Resolving List は Link 

Layerの一部です。そのため、Link Layerは Resolving Listを使用して RPAをアイデンティティー アドレスに解読してから、

Whitelist を使用してアイデンティティー アドレスをフィルタリングできます。Bluetooth 4.2 における接続可能有向宣伝による

デバイス フィルタリングにより、プライバシー機能を備えた BLEデバイスのより高速な再接続が可能です。 

7.3.2  電力効率の良い GAP セントラル  デバイス  

デバイス フィルタリングを使用する、プライバシー機能を備えた GAP セントラル デバイスに対しては、Link Layer は

Resolving List と Whitelist にリストアップされたピア デバイスからの有向宣伝およびスキャン応答をのみ BLE スタックに送

信します。これにより、BLEスタックでの必要な処理が減少されます。サイプレスの PSoC 4 BLE と PRoC BLEのような BLE

デバイスは、BLE スタックを MCU で実行されるファームウェアとして、Link Layer をハードウェア ブロックとして実装します。

そのため、BLE スタックでの必要な処理が減少されることにより、MCU のアクティブ時間が短縮され、システムの消費電力も

減少されます。  

7.3.3  電力効率の良い GAP ペリフェラル  デバイス  

デバイス フィルタリングを使用する、プライバシー機能を備えた GAP ペリフェラル デバイスに対しては、Link Layer は

Resolving List と Whitelist にリストアップされたピア デバイスからのスキャン要求および接続要求をのみ BLE スタックに送

信します。これにより、BLEスタックでの必要な処理が減少されます。サイプレスの PSoC 4 BLE と PRoC BLEのような BLE

デバイスは、BLE スタックを MCU で実行されるファームウェアとして、Link Layer をハードウェア ブロックとして実装します。

そのため、BLE スタックでの必要な処理が減少されることにより、MCU のアクティブ時間が短縮され、システムの消費電力も

減少されます。 

http://www.cypress.com/
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7.3.4  Bluetooth 4.1 よりプライベート  

7.2.5節に記述したように、Bluetooth 4.1におけるプライバシー機能は固定された 15分の RPAタイムアウトを使用しますが、

Bluetooth 4.2における RPA タイムアウトは最小 1秒です。これにより、Bluetooth 4.2では RPAがより頻繁に変化し、BLE

デバイスのトラッキングは困難になります。  

7.4 アプリケーション 

Link Layerプライバシー機能を採用する応用は多くあります。 

プライバシー機能により、利用者は体育館などの公共の環境でウェアラブル機器の可視性を制御できます。プライバシー機

能を備えたウェアラブル機器が利用者のスマートフォンや体育館の設備に接続しようとする時、それからの宣伝は 3 番目の

デバイスによってトラッキングされることはできません。これにより、公共の場所で利用者はウェアラブル機器をとおしてトラッ

キングされることは防げます。ほとんどのウェアラブル機器は GAP ペリフェラルであり、消費電力が大きいため Bluetooth 

4.1におけるプライバシー機能を使用しません。Bluetooth 4.2における Link Layerプライバシー機能により、7.3.3節で説明

したように消費電力が減少されるため、ウェアラブル機器はプライバシー機能を使用できます。  

小売業アプリケーションもプライバシー機能によって利益を得られます。小売業環境で、サービス提供者は BLE ビーコンを採

用して広告を介して利用者のスマートフォンにオファーを送信します。Link Layer プライバシー機能に対応したスマートフォン

は、デバイス フィルタリングを (7.3.1節で説明したように) 使用して望ましいサービス提供者からのオファーのみを受信し、他

のサービス提供者を無視します。  

Link Layerプライバシー機能により、RPAが頻繁に変化するため公共の場所で利用者のスマートフォンをトラッキングすることが

困難になります。一般的には、スマートフォンは GAPセントラル デバイスとして動作します。また、Link Layerプライバシーに

より、(7.3.2節で説明したように) スマートフォンの BLE通信に消費される電力量は減少されます。 

7.5 Link Layerプライバシーを採用したアプリケーションの PSoC Creatorによる開発 

7.5.1  コンポーネントのコンフィギュレーション  

Link Layerプライバシー機能および関連する APIは、図 24に示すように GAP Settings > Securityの下の BLEコンポー

ネント コンフィギュレーション ウィンドウ内の Enable Link Layer Privacyオプションで有効／無効にできます。 

図 24. Link Layerプライバシーの有効化／無効化 

 

http://www.cypress.com/
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GAP サービスのセントラル アドレス解読キャラクタリスティックは、初期の接続確立の後に GAP ペリフェラル デバイスによって
読み出されます。このキャラクタリスティックの値により、GAP ペリフェラルは GAP セントラルが Link Layer でのアドレス解読を
サポートするかを理解できます。Link Layer でアドレス解読がサポートされる場合、GAP ペリフェラルは GAP セントラルとの
再接続のために接続可能有向宣伝を使用できます。セントラル アドレス解読キャラクタリスティックの値は、図 25 に示すよう
に、Profiles > Generic Access > Central Address Resolutionの下のドロップダウン メニューでセットできます。Link Layer

プライバシーに対応したデバイスは、この機能がサポートされることをピア デバイスに通知するためにこのキャラクタリスティッ
ク値を Supportedにセットする必要があります。 

図 25. セントラル アドレス解読キャラクタリスティック値の設定 

 

7.5.2  アプリケーションの処理  

アプリケーション ファームウェアは、プライバシー機能を備えたデバイスのファームウェアで以下のタスクを管理する必要があります。 

▪ アドレス解読の有効化／無効化 

▪ RPAタイムアウトの設定 

▪ Resolving Listに／からのデバイスの追加／除外 

▪ 適切なWhitelistフィルター ポリシーの設定 

表 8では、BLEスタック イベント、イベントの説明、およびイベント ハンドラで行うべき応答処理をリストアップします。 

表 8. LLプライバシー用の BLEイベントおよび措置 

BLEスタック イベント名 イベントの説明 イベント ハンドラの応答処理 

CYBLE_EVT_STACK_ON BLEスタックの初期化が正常に完了 Resolving Listに入力  

アドレス解読を有効化 

RPAタイムアウトを設定 

Whitelistフィルター ポリシーを設定  

CYBLE_EVT_GAP_KEYINFO_EXCHNGE_CMPLT ピア デバイスとのセキュリティ キー交換が

完了 

ピア デバイスの IRKをコピー  

Resolving Listを更新 

Whitelistフィルター ポリシーを更新 

CYBLE_EVT_GAPC_DIRECT_ADV_REPORT アドレス解読の後に有向宣伝を受信 デバイスに接続  

 

http://www.cypress.com/
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表 9は、LLプライバシーに対応したアプリケーションで使用される新しい APIを一覧化したものです。 

表 9. LLプライバシー機能に対応したアプリケーションの新しい API 

API 説明 

CyBle_GapAddDeviceToResolvingList Resolving Listにデバイスを追加 

CyBle_GapRemoveDeviceFromResolvingList Resolving Listからデバイスを除外 

CyBle_GapSetAddressResolutionEnable コントローラーでアドレス解読を有効化 

CyBle_GapSetResolvablePvtAddressTimeOut RPAタイムアウトを設定 

CyBle_GapReadResolvingList 現時点の Resolving Listを読み出す 

CyBle_GapReadPeerResolvableAddress ピア デバイスの現時点の RPAアドレスを読み出す 

CyBle_GapReadLocalResolvableAddress ローカル デバイスの現時点の RPAアドレスを読み出す 

CyBle_GapGetDevSecurityKeyInfo ローカル IRK値を取得 

7.5.3  セントラル  アドレス解読キャラクタリスティックの読み出し  

7.5.1 節に記述したように、ペリフェラル デバイスはプライバシー機能を備えたセントラル デバイスが Link Layer プライバシーを 

サポートする場合にのみ、セントラル アドレス解読キャラクタリスティックを読み出し接続可能有向宣伝を送信します。セントラル  

アドレス解読キャラクタリスティックを読み出すために、以下に示すように CyBle_GattcReadUsingCharacteristicUuid 

APIを適切なパラメーターで使用できます。 

CYBLE_GATTC_READ_BY_TYPE_REQ_T read_by_type_req; 

read_by_type_req.range.startHandle = CYBLE_GATT_ATTR_HANDLE_START_RANGE; 

read_by_type_req.range.endHandle = CYBLE_GATT_ATTR_HANDLE_END_RANGE; 

read_by_type_req.uuid.uuid16 = CYBLE_UUID_CHAR_CENTRAL_ADDRESS_RESOLUTION; 

read_by_type_req.uuidFormat = CYBLE_GATT_16_BIT_UUID_FORMAT; 

CyBle_GattcReadUsingCharacteristicUuid(cyBle_connHandle,&read_by_type_req); 

セントラル デバイスがセントラル アドレス解読キャラクタリスティックを持っている場合、キャラクタリスティックおよびアトリビュート 

ハンドルは CYBLE_EVT_GATTC_READ_BY_TYPE_RSP イベントでアプリケーションに渡されます。アプリケーションは、 

キャラクタリスティックの値をチェックして、次の再接続に接続有向宣伝を使用するかを決定します。  

7.5.4  Resolving List に／からのデバイスの追加／除外  

新しい BLE デバイスは、ローカル IRK、ピア IRK、ピア  アイデンティティー  アドレスをパラメーターとした

CyBle_GapAddDeviceToResolvingList APIにより、図 17に示した Resolving Listに追加できます。 

CYBLE_GAP_RESOLVING_DEVICE_INFO_T rpaInfo; 

memcpy(&rpaInfo.bdAddr,&peer_ID_Addr[1],CYBLE_GAP_BD_ADDR_SIZE); 

rpaInfo.type = smp_key->idAddrInfo[0]; 

memcpy(rpaInfo.localIrk,local_irk,CYBLE_GAP_SMP_IRK_SIZE); 

memcpy(rpaInfo.peerIrk,smp_key->irkInfo,CYBLE_GAP_SMP_IRK_SIZE); 

/* Add device to resolving list */ 

CyBle_GapAddDeviceToResolvingList(&rpaInfo); 

ピア IRKおよびピア アイデンティティー アドレスは CYBLE_EVT_GAP_KEYINFO_EXCHNGE_CMPLTイベントでアプリケーションに渡

されます。アプリケーションはこれらの値を保存しなければなりません。ローカル IRK は CyBle_GapGetDevSecurityKeyInfo 

APIで取得できます。  

デ バ イ ス を Resolving List か ら 除 外 す る た め に 、 デ バ イ ス の ア イ デ ン テ ィ テ ィ ー  ア ド レ ス で

CyBle_GapRemoveDeviceFromResolvingList APIを呼び出します。 

これらのイベントおよび APIの詳細については、BLEコンポーネントのデータシートを参照してください。  

http://www.cypress.com/
http://www.cypress.com/documentation/component-datasheets/bluetooth-low-energy-ble
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7.5.5  サンプル  プロジェクト  

Link Layer プライバシーを採用したサンプル プロジェクトについては、PSoC Creator で提供されるサンプル プロジェクト

BLE_4.2_DataLength_Security_Privacy を参照してください。図 10 に示すように、PSoC Creator > File > Code 

Exampleで BLEに絞り込むことでサンプル プロジェクトにアクセスできます。 

8 まとめ 

本アプリケーション ノートは Bluetooth LE 4.2 仕様で紹介される新しい機能とそれらの利点、およびそれらを採用したアプリ

ケーションを開発する方法について説明しました。 

9 関連アプリケーション ノート 

AN94020 - Getting Started with PRoC™ BLE 

AN91267 - Getting Started with PSoC® 4 BLE 

AN97060 - PSoC® 4 BLE and PRoC™ BLE - Over-The-Air (OTA) Device Firmware Upgrade (DFU) Guide 

AN91184 - PSoC 4 BLE - Designing BLE Applications 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an94020-getting-started-proc-ble
http://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
http://www.cypress.com/documentation/application-notes/an97060-psoc-4-ble-and-proc-ble-over-air-ota-device-firmware-upgrade
http://www.cypress.com/documentation/application-notes/an91184-psoc-4-ble-designing-ble-applications
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A 受動的盗聴に対する防止 
楕円曲線ディフィー ヘルマン (ECDH) アルゴリズムにより、2 つの BLE デバイスは LE セキュア コネクションに基づいた 

ペアリングを使用して共有秘密キーを確立できます。共有秘密キー (ディフィー ヘルマン キー) は、BLE リンクを暗号化する

長期キー (LTK) を生成するために、ペアリング プロセスの第 2フェーズ (認証ステージ 2) で使用されます。ディフィー ヘルマン 

キーは 256ビットの乱数を提供し、図 26に示すように無線で交換されません。  

図 26. 共有秘密キーの ECDHによる確立 

 

1 「primitive root modulo」については、George E. Andrews著 『Number Theory』 (ISBN-10:0486682528) を参照してください。 

 

http://www.cypress.com/
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B 中間者 (MITM) 攻撃に対する防止 
以下の節は、LE セキュア コネクション ベースのペアリングの数値比較、パスキー入力、および帯域外 (OOB) アソシエーション 

モデルがどのように MITMの攻撃を防ぐかについて説明します。 

B.1 数値比較アソシエーション モデル 

図 27 には、数値比較アソシエーション モデルが LE セキュア コネクションに使用される時のペアリング プロセスの認証 

ステージ 1を示します。  

図 27. 数値比較の認証ステージ 1 

 

数値比較アソシエーション モデルは、MITMの攻撃を防止するために以下の認証手段を使用します。 

▪ 応答デバイスは、発信デバイスの乱数 (Na) を受信する前に、応答デバイスの乱数 (Nb) と両方の BLEデバイスの公開

キーで計算されたコミットメント値 (Cb) を共有しなければなりません。 

▪ 発信デバイスは、応答デバイスの乱数 (Nb) を受信する前に、発信デバイスの乱数 (Na) を共有しなければなりません。 

▪ 発信デバイスは、応答デバイスの乱数 (Nb) を受信した後、コミットメント値 (Cb) をチェックしなければなりません。 

図 28には、MITM攻撃者がまず応答デバイスと乱数を交換してから、発信デバイスと乱数を交換するシナリオを示します。  

http://www.cypress.com/
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図 28. MITM攻撃者がまず応答デバイスと乱数を交換してから、発信デバイスと乱数を交換 

 

図 28からわかるように、攻撃者は応答デバイスの乱数 (Nb) にアクセスする前に、攻撃者の乱数 (Nc) を応答デバイスと共

有しなければなりません。このため、両方の BLE デバイスは異なる 6 桁の値を表示し、その結果、ユーザーが表示された値

を確認する時に認証失敗となります。 

図 29には、MITM攻撃者がまず発信デバイスと乱数を交換してから、応答デバイスと乱数を交換するシナリオを示します。 

図 29. MITM攻撃者がまず発信デバイスと乱数を交換してから、応答デバイスと乱数を交換 

 

図 29からわかるように、攻撃者は発信デバイスの乱数 (Na) にアクセスする前に、攻撃者のコミットメント値 (Cc) を発信デバ

イスと共有しなければなりません。発信デバイスはコミットメント値をチェックすることで、攻撃者が発信デバイスの乱数を変更

しないようにします。このため、両方の BLEデバイスは異なる 6桁の値を表示し、その結果、ユーザーが表示された値を確認

する時に認証失敗となります。 

http://www.cypress.com/
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B.2 パスキー入力アソシエーション モデル 

図 30には、パスキー入力アソシエーション モデルが LEセキュア コネクションに使用される時のペアリング プロセスの認証

ステージ 1を示します。  

図 30. パスキー入力の認証ステージ 1 

 

パスキー入力アソシエーション モデルは、MITMの攻撃を防止するために以下の認証手段を使用します。 

1. 両方の BLEデバイスは、ユーザー入力として共通の 6桁または 20ビットのパスキー (ra と rb) を受信します。 

2. ステップ 3～7は、パスキー内のそれぞれのビット (すなわち、i = 1, 2,….20) に対して繰り返されます。  

3. 両方の BLEデバイスは 128ビットの乱数 (Nai と Nbi) を選択します。 

4. 発信デバイスは、両方の BLEデバイスの公開キー (PKa と PKb)、128 ビットの乱数 (Nai) およびパスキーの i番目の 

ビット (rai) で計算されたコミットメント値 (Cai) を共有します。 

5. 応答デバイスは、両方の BLEデバイスの公開キー (PKa と PKb)、128 ビットの乱数 (Nbi) およびパスキーの i番目の 

ビット (rbi) で計算されたコミットメント値 (Cbi) を共有します。 

6. 発信デバイスは 128ビットの乱数 (Nai) を応答デバイスと共有します。 

7. 応答デバイスは、発信デバイスの 128 ビット乱数 (Nai) を使用して発信デバイスから受信したコミットメント値 (Cai) を 

チェックします。チェックが合格した場合、応答デバイスは 128ビット乱数 (Nbi) を発信デバイスと共有します。 

8. 発信デバイスは、応答デバイスの 128 ビット乱数 (Nbi) を使用して応答デバイスから受信したコミットメント値 (Cbi) を 

チェックします。チェックが合格した場合、発信デバイスはペアリング プロセスを継続します。 

パスキー入力アソシエーション モデルの中心は、パスキーの少しずつ (ビットずつ) の公開です。発信デバイスおよび応答 

デバイスと関わり合う MITM 攻撃者は、BLE デバイスがコミットメント値のチェックの不合格を検出してペアリング プロセスを

中止する前に、パスキーの 2ビットにのみアクセスできます。数値比較アソシエーション モデルに比べると、パスキー入力アソ

シエーション モデルのデメリットは、認証手段の 20回の繰り返し (パスキーのビットごとに 1回) のためペアリング プロセスに

時間がかかることです。  

B.3 帯域外 (OOB) アソシエーション モデル 

OOB 通信が MITM 攻撃に対して耐性があるため、OOB アソシエーション モデルも MITM 攻撃に対して耐性があります。OOB 

アソシエーション  モデルの主なデメリットは、両方の BLE デバイスが通信のために BLE インターフェースに加えて 

OOB インターフェースを備えなければならないことです。OOB インターフェースのため、BLE デバイスのコストは増加します。

OOBアソシエーション モデルの詳細については、「Bluetooth Core Specification Version 4.2」の第 3巻、第 H部、2.3.5.6

節を参照してください。   
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